Table of Contents

I. Installation and Review of the MAF/TIGER Partnership Software ........................................... 5
   A. Installation .......................................................................................................................... 5
      New for 2010 Census: Nonvisible Voting District Boundaries ........................................ 7
      Delineating VTDs Prior to Making Block Boundary Suggestions .................................. 7
   B. VTD/BBSP “Help” ............................................................................................................ 7
   C. Starting the MTPS for VTD/BBSP/Selecting a County ................................................ 7
   D. Working with your Selected County .............................................................................. 8
   E. The “Standard” Toolbar & Map “Layers” Dialog Box .................................................... 10
   F. The “Tools” Toolbox ........................................................................................................ 12
   G. The “VTD Editing” Toolbox .......................................................................................... 14
   H. To Reset the Edit Layer (Use with Caution!) ................................................................. 16
   I. Backing Up Your Work .................................................................................................. 16
   J. Data Corruption ............................................................................................................... 16

II. Creating and Modifying VTDs .............................................................................................. 17
   A. To Create a New VTD ...................................................................................................... 17
   B. To Create VTDs Using a Layer From Your VTD Database as the Source .................. 20
   C. If Your State Data Doesn’t Match Census Bureau Data .............................................. 21
   D. To Create VTDs Using Your Block Equivalency File .................................................. 23
   E. To Create VTDs Using Your Census 2000 VTDs ......................................................... 27
   F. To Modify a VTD That Has Been Created Using Any of the Above Methods ..........27

III. Editing your VTDs ............................................................................................................... 29
   A. To Find Unassigned VTD Areas ..................................................................................... 29
   B. To Find Noncontiguous VTDs ....................................................................................... 29

IV. Adding Lines and Providing Imagery ............................................................................... 31
   A. To Add a Line .................................................................................................................. 31
   B. Importing Imagery from TerraServer-USA .................................................................. 34
   C. Adding Your Own Digital Imagery as a Layer ............................................................ 35
   D. Mailing or Faxing an Image or Map ............................................................................. 35
   E. Providing a URL to Display an Image or Map ............................................................... 35

V. Performing Block Boundary Suggestion Project Tasks .................................................... 36
   A. Feature Extension Criteria ............................................................................................... 36
   B. Planned 2010 Census Tabulation Block Boundaries .................................................... 36
   C. To Review Census 2000 “Must Holds” and “Do Not Holds” ..................................... 39
   D. To Review Planned and Ineligible 2010 Census Tabulation Block Boundaries .......... 39
   E. To Make Block Boundary Suggestions ...................................................................... 40
   F. To Change the BBSP Display Settings ......................................................................... 41
   G. To Find Feature Extensions ......................................................................................... 41
   H. To Review Block Boundary Suggestions ................................................................... 43
I. To Move Around the BBSP Map ............................................................................................................. 44
J. To Create a Block Area Group (Island Grouping) .................................................................................. 44
K. To Delete a Block Area Group That You Have Created ......................................................................... 45
L. Dividing Large Water Blocks .................................................................................................................. 45
M. Dividing Long Narrow Blocks formed by Medians ................................................................................ 45
N. To Verify Your VTD/BBSP Work ............................................................................................................. 45

VI. Reporting and Viewing your Submission .............................................................................................. 47
A. To Report Your VTD/BBSP Changes ....................................................................................................... 47
B. To View Your VTD/BBSP Changes after Reporting .............................................................................. 47
C. Submitting Files Using the Census Bureau’s “Send a File Utility” ......................................................... 48

Note: Grey highlighted text indicates updates since Version 2
I. Installation and Review of the MAF/TIGER Partnership Software

The MAF/TIGER Partnership Software (MTPS) is the Census Bureau’s primary tool for submission and review of Voting Districts (VTDs) and Block Boundary Suggestions. This attachment to the General Guidelines provides specific instructions on the installation and use of the MTPS for submitting VTDs and block suggestions to the Census Bureau.

It is very important that you read this document in its entirety, as the sections build upon each other and each step is important.

You will find the MTPS on the CD provided to your state for this project. It is labeled “MAF/TIGER Partnership Software; Program Disc.” It is designed to work with Windows based PCs and will run on Windows 98, 2000, ME, NT, and XP. You also will find a CD/DVD data disc. The data disc includes entity layers in ESRI shapefile¹ format. Depending on your computer and equipment, and the size of your state, installation of the MTPS and the data can take up to 45 minutes.

The software and data may be loaded into more than one computer. However, make sure that only one person is working on a county. Multiple data sets cannot be merged for the same county.

Also, since the MTPS is built on Maptitude, and only one Maptitude session can run at a time, you must first close any other Maptitude session before opening the MTPS.

A. Installation

To install the MTPS, follow these steps:

1. “Start” Windows.
2. Insert the Program CD into your CD drive.
3. If the “Installation Wizard” does not automatically start up, choose the “Run” command from the “Start” menu.

¹ The use of brand names does not represent an endorsement of a company or its products by the U.S. government. Due to the wide use of ESRI products by our partners in the GIS community, and the ubiquitous use of the shapefile format as a medium for GIS data exchange, the Census Bureau is providing this data in shapefile format.
4. Type the location of your CD drive plus the word “setup” (for example, type `d:\setup`), or use the “Browse” button to locate the `setup.exe` file on the CD.

5. Click “OK.” In a moment, the installation program will appear on your screen.

6. On the “Welcome” screen, click “Next.”

7. For “Installation Type,” choose “Single User” and click “Next.”

8. The setup program guides you through the installation process, asking questions and making suggestions along the way. It is best to accept the default settings. The MTPS sets up a folder on your C drive called “MTPS Data.”

9. Once the program has been installed, the setup program indicates that “Setup Needs the Census Data” to prompt you to insert the Census RDP State Data CD/DVD. Remove the program CD and insert the RDP State Data CD/DVD. Browse to where the Census State Data CD/DVD is located and click “OK.” The file name will be RDP_ss, where ss = the FIPS code for your state.

10. After the state data files are copied, the installation process is complete and the “Setup” is finished. Click on “Finish.”

11. Click the “Start” button on the Windows taskbar and from the Programs menu, choose “MAF-TIGER Partnership Software” and then “MAF-TIGER Partnership Software 4.7.”

12. Click “OK.” This will display the “Please Log In” dialog box. Enter the User Name “RDP” (case sensitive).

13. Click “OK.”

14. You are then prompted with two “Startup Choices”:

   - Run the MAF/TIGER Partnership Software Computer Based Training (CBT)
   - Go Directly to the MAF/TIGER Partnership Software program (default)

**When you first open the software, take the time to run the CBT.**

Even if you are a sophisticated GIS user, reviewing the CBT will provide you with time-saving information.

Once you have begun to use the software, you can refer back to the CBT by choosing “Start (your Windows start button)® Programs® MAF-TIGER Partnership Software® Computer Based Training for MAF-TIGER Partnership Software.”
New for 2010 Census: Nonvisible Voting District Boundaries

The Census Bureau has changed its policy on the acceptance of VTD boundaries. In the past, we required you to modify your VTDs that followed nonvisible boundaries, such as section lines or rear lot lines. Although we still believe visible features make better geographic boundaries, we will accept nonvisible VTD boundaries. If you have VTDs that follow nonvisible lines, we require you to provide us with a description of the line. If your state requires the VTDs to follow visible features, the Census Bureau expects the State Liaison to communicate that information to any local officials submitting the VTDs and modify the submission to comply with the state law.

Delineating VTDs Prior to Making Block Boundary Suggestions

The MTPS is designed for you to do your VTD work first, followed by the block boundary suggestion work. Because your VTD boundaries will be held as 2010 Census tabulation block boundaries, delineating your VTD boundaries first may preclude your having to suggest as many “Must Holds.”

B. VTD/BBSP “Help”

Review the on-line help for the VTD/BBSP program by choosing from the top menu, Help ➔ Contents ➔ MTPS Census Programs Help ➔ VTD/BBSP. Here you will find more detailed information regarding the topics included in this document. The “Help” menu also provides instructions for various other topics. For instance, under “Basic Skills” you can learn how to create layouts that you can use in documents or reports. You can preview and make changes to a layout, and edit and replace maps and dataviews, and print a layout. The “Help” menu also includes an “Index” tab at the top and you can search on a topic.

Note: To learn more about a command, dialog box, or toolbox, open or highlight the item and press F1 to get the appropriate topic in the on-line help. To review the function of an icon on any toolbox, hover the cursor over the icon and a text box will appear describing the function.

C. Starting the MTPS for VTD/BBSP/Selecting a County

Before you can open the VTD/BBSP map window you must pick a county to work with. The MTPS will then import the data for that county. The MTPS is designed to work on one county at a time, with the option to view adjacent counties, including any updates that have been made. Each time you open the VTD/BBSP map window, it will display the last county you were editing. To work with a different county you must close the VTD/BBSP Map window, pick another county, and open the VTD/BBSP map window again.
To select a County (or county equivalent) follow these steps:

1. Choose, from the menu bar at the top, VTD/BBSP → Pick a County. The MTPS displays the “MTPS Counties” dialog box.

2. Highlight a county in the scroll list.

3. Click “OK.”

Before starting the import process, the MTPS displays a message to recommend that you disable any anti-virus software to speed the process. When you click “OK,” the MTPS imports the county, makes it the current county, and displays a message indicating success. Depending on your equipment and the size of the county, importing a county could take up to 10 minutes. When this is complete, a message box pops up saying that your county was imported successfully.

**Note:** Your session continuously saves while working. You can also save and re-open your session at any time. Your session saves when you close the county.

**D. Working With Your Selected County**

1. Choose VTD/BBSP → Open. The MTPS displays the VTD/BBSP map window.

2. If this is the first time you have run the VTD/BBSP module for a given county, the software presents you with this box:
“Start with existing features” means that your map will include the VTDs submitted for use in the Census 2000 tabulation P.L. 94-171 data products. Those are likely to be a 1998 vintage. If the VTDs of your state do not change frequently, you may want to use the Census 2000 VTDs as a reference or starting point. If this is the case, use the default selection, “Start with existing features.” Instructions for this approach are included in the section called “Create VTDs using your Census 2000 VTDs” on page 27.

If viewing the older VTDs would be of no help to you in submitting VTDs for the 2010 Census, select “Create empty layer.” Instructions for this approach are included in the section called “To Create a New VTD” on page 17.

If you want to create your VTDs starting with a block equivalency file that you have maintained in your own database or GIS application, select “Import Equivalency.” Instructions for this approach are included in the section called “To Create VTDs Using Your Block Equivalency File” on page 23.

After selecting your approach, click “OK.”

**Note:** If your state did not submit Census 2000 VTDs, the only available options are “Create empty layer” or “Import Equivalency.”

3. The “Standard” toolbar appears across the top of the screen and the MTPS opens the “Tools” and “VTD Editing” toolboxes, and the “Map Layers” legend.

**Note:** To learn more about a command, dialog box, or toolbox, open or highlight the item and press F1 to get the appropriate topic in the on-line help. To review the function of an icon on any toolbox, hover the cursor over the icon and a text box will appear describing the function.

The “Map Layers” Legend shows which layers are displayed. The default setting shows all layers in the MTPS except Census 2000 blocks, block groups, state legislative districts, and congressional districts.
E. The “Standard” Toolbar and Map “Layers” Dialog Box

You can turn map layers on or off depending on what you want displayed on the map. For example, if your VTDs have nothing in common with school districts, there is no need to display them and you should turn that layer off. If you want to review your SLDs or CDs to ensure that the relationships they have with other governmental units is intact, you should turn those layers on.

Note that the first item listed in the “Layers in Order of Display” column (described below), VTD, is the first layer drawn on the map. The remaining layers are drawn sequentially, with each added layer being drawn on top of the previous one.

Use the map Layers dialog box on the Standard toolbar across the top of the screen to see the map layers and their settings, as follows:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Layers dialog box</td>
<td>Choose “Map ➔ Layers” or click on the Standard toolbar, or click the right mouse button on the map window and choose “Layers.” The MTPS displays the “Layers” dialog box.</td>
</tr>
<tr>
<td>Choose a layer</td>
<td>Within the layers dialog box, highlight the layer in the scroll list. This list shows the layers in the order they will be drawn, a sample of the style, and the status.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hidden</strong> means the layer will not be drawn.</td>
</tr>
</tbody>
</table>

You can turn map layers on or off depending on what you want displayed on the map. For example, if your VTDs have nothing in common with school districts, there is no need to display them and you should turn that layer off. If you want to review your SLDs or CDs to ensure that the relationships they have with other governmental units is intact, you should turn those layers on.
• **Autoscale** means the layer will be drawn between certain scales.

• **Blank** means the layer will be drawn at all scales. You can also hold the Shift key and click on another layer to highlight a range of layers, or hold the Ctrl key and click on a layer to toggle the highlight on or off and select multiple layers.

**Hide** a layer

Click “Hide Layer.” The button will change to “Show Layer” so that you can reshown the layer. The layer’s status will change to “Hidden.”

**Add** a layer

Click “Add Layer” to display the “File Open dialog” box. You can choose the type of file and one or more files to open. Click “Cancel” to close the dialog box without adding any layers.

**Drop** a layer

Click “Drop Layer.” The MTPS displays a “Confirm” dialog box. Click “Cancel” to close the dialog box without dropping the layer. **Only drop layers that you have imported from your own shapefile.** If you do not want to see a layer that is included in the MTPS, you should “Hide” the layer rather than drop it.

Change the **order** of the layers

Click “Move Up” or “Move Down.” The MTPS moves the highlighted layer up or down.

Change the **style** settings for a layer

Click “Style” to display the “Style” dialog box, which is different for point, line, and area layers. You can choose different styles from the dropdown settings. Your selections are illustrated in the box to the right of the settings. Click “Apply” if you want to try out changes to style settings, but click “Cancel” to close the dialog box without changing the settings. If you want to save these settings, click “OK.”

Change the **label** settings for a layer

Click “Labels” to display the “Automatic Labels” dialog box. Click “Apply” if you want to try out changes to label settings, but click “Cancel” to close the dialog box without changing the settings. If you want to save these settings, click “OK.”

Change the **autoscale** settings for a layer

Click Autoscale to display the “Autoscale” dialog box. The Largest dropdown list, if not blank, shows the largest scale at which to display the layer, as you zoom in. The smallest dropdown list, if not blank, shows the smallest scale at which to display the layer, as you zoom out. Click “Cancel” to close the dialog box without changing the settings.

**Close the Layers dialog box**

Click “Close.”

**Additional Labeling Information**

The MTPS labeling engine places the labels on the center of the district. If the center of the district is outside of the district itself (as in a crescent shaped district), the label is supposed to be attached to the edge nearest to the center point. The labels are static in that they will not move as you zoom and pan.
The labeling engine makes a determination of which labels to draw and which to suppress when the drawing of all the labels would cause them to overlap. If you are zoomed into where the individual blocks are being labeled, this "knocks out" the VTD labels in some areas where drawing them would force an overlapping label. If you wish to see those labels and you don't need the block labels, turn off the block labels. As long as no other area or feature labels would intrude, your VTD labels should then appear.

F. The “Tools” Toolbox

Use the tools on the “Tools” toolbox to move around the map and change the map scale, as follows:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in to a point or a rectangle</td>
<td>Click on the “Tools” toolbar and click on a point or drag a rectangle. The MTPS increases the scale and changes the center of the map.</td>
</tr>
<tr>
<td>Zoom out from a point or a rectangle</td>
<td>Click on the “Tools” toolbar and click on a point or drag a rectangle. The MTPS makes the scale smaller and changes the center of the map.</td>
</tr>
<tr>
<td>Move the map in any direction</td>
<td>Click on the “Tools” toolbar and drag the map. The MTPS changes the center of the map.</td>
</tr>
<tr>
<td>Return to the previous scale and center</td>
<td>Choose, from the top menu bar “MapÆPrevious Scale” or click on the “Tools” toolbar.</td>
</tr>
<tr>
<td>Return to the original scale and center</td>
<td>Choose, from the top menu bar “MapÆOriginal Scale” or click on the “Tools” toolbar.</td>
</tr>
</tbody>
</table>

Use the Info tool to see the attributes for a layer, as follows:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the working layer</td>
<td>Choose the layer you want from the dropdown list on the “Standard” toolbar.</td>
</tr>
<tr>
<td>Get information on a map feature</td>
<td>Click on the “Tools” toolbar to activate the Info tool and click on a feature on the map. The MTPS marks the feature with an “i” and displays the data for the feature in the Info window.</td>
</tr>
<tr>
<td>Get information on several features</td>
<td>Click on the “Tools” toolbar to activate the Info tool and drag a circle around the map features. The MTPS marks the features</td>
</tr>
</tbody>
</table>
with an “i” and displays the data for the features in the Info window.

Get information on several layers  Click on the “Tools” toolbar to activate the Multi-Layer Info tool. Click at a location on the map. MTPS displays the Multi-Layer Information toolbox, and shows the information for the first feature in the first layer.

Get information on area layers  Click on the “Tools” toolbar to activate the Multi-Layer Area Info tool. Click at a location on the map. MTPS displays the Multi-Layer Area Information toolbox, and shows the information for the features in the chosen area layers.

Measure distance between points  Click on the “Tools” toolbar to activate the Distance tool.
  o  Click on the map at the starting point. MTPS starts a line at the point you marked. MTPS displays the elapsed length of the line in the status bar at the bottom of the screen.
  o  If the line is not straight, click on one or more shape points. MTPS continues the line through each one.
  o  Double-click on the last point to end the line. MTPS displays the total length of the line in a Note dialog box.
  o  Click OK to close the dialog box.

Measure the size of an area  Click on the “Tools” toolbar to activate the Size tool.
  o  Click on the map at the starting point of the area. MTPS starts a line at the point you marked.
  o  Click on the corners of the area. MTPS continues the line through each one.
  o  Double-click to end the area. MTPS connects the first and last point automatically. MTPS displays the size of the area (in map units and acres) and its perimeter (in map units) in a Note dialog box.
  o  Click OK to close the dialog box.

Change the fields that are displayed  Right click on the “Info” window and choose “Field Sets,” highlight an existing set or click Add to create a new set, and click “OK.” The MTPS displays just the fields in the field set, in the order you chose.

Close the Info window  Click the “Close” box in the upper right corner.
G. The “VTD Editing” Toolbox

Depending on your method of creating VTDs (by using your 2000 VTDs, creating new VTDs from an empty layer, or importing your own shapefiles or block equivalency files) you will make different selections. Refer to the various methods in Section II, beginning on page 17, in order to decide what to select from the different dropdown menus.

The dropdown selections in the “VTD Editing” toolbox are:

- **Edit Layer:** The layer to edit (What are you going to create or update; VTD, SLD, or CD?)
- **Target Area:** The area to edit, either a new district, an existing district, or the unassigned area
- **Source Area:** The areas from which to select, either all areas, an existing district, or the unassigned area
- **Selection Layer:** The layer from which to select (If your VTDs are coextensive with incorporated places, you may want to select incorporated places here.)

1. Choose an edit layer from the “Edit Layer” dropdown list in the “VTD Editing” toolbox. (Selections are Voting District for creating new VTDs or viewing 2000 VTDs; or SLD lower, SLD upper, and Congressional District for corrections to these existing entities.)

2. Choose a Target Area as follows:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick the target area in the toolbox</td>
<td>Choose a target area from the “Target Area” dropdown list</td>
</tr>
</tbody>
</table>

**OR**

| Pick the target area on the map | Click [ and click in an area on the map |

| Create a new target area | Choose “New District” from the “Target Area” dropdown list |

The MTPS makes the area you select the target area and, if it is an existing area, shades it on the map. If your water layer is turned on and there is water in the area, the water will be displayed instead of the shading. You may want to turn your water layer off at this point.
3. Use the following buttons in the “VTD Editing” toolbox:

<table>
<thead>
<tr>
<th>To zoom to…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>An existing target area</td>
<td>Click <img src="image1" alt="icon" /> The MTPS zooms the map so that the whole target area is visible. You cannot zoom to the target area if you chose “New District” in the “Target Area” dropdown list.</td>
</tr>
<tr>
<td>The entire map</td>
<td>Click <img src="image2" alt="icon" /> The MTPS zooms to show the entire map.</td>
</tr>
</tbody>
</table>

**Note:** You can also use tools in the “Tools” toolbox to move around the map.

Other buttons in the “VTD Editing” toolbox:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update target area attributes</td>
<td>Click <img src="image3" alt="icon" /> to display the Attributes dialog box. Make updates as necessary.</td>
</tr>
<tr>
<td>Delete all work in the county</td>
<td>Click <img src="image4" alt="icon" /></td>
</tr>
<tr>
<td>Choose areas to create a VTD</td>
<td>Click <img src="image5" alt="icon" /> to select one or more areas, or click and drag a rectangle around areas to select them. The entire polygon or face must be within the rectangle or shape in order to be included.</td>
</tr>
<tr>
<td>Unselect a face</td>
<td>Hold the &lt;Ctrl&gt; key while using the pointer tool (above) on the face. This will unselect it.</td>
</tr>
<tr>
<td>Select areas by shape</td>
<td>Click <img src="image6" alt="icon" /> to select areas within a shape, then click on the map and move your mouse and click again until all the areas you want to select are inside the shape. Double click to end. The entire polygon or face must be within the rectangle or shape in order to be included.</td>
</tr>
<tr>
<td>Save work on current action</td>
<td>Click <img src="image7" alt="icon" /></td>
</tr>
<tr>
<td>Undo work on current action</td>
<td>Click <img src="image8" alt="icon" /></td>
</tr>
<tr>
<td>that has not been saved</td>
<td>From the menu selections across the top of the Standard Toolbar, select “Edit,” “Undo”. It starts with undoing whatever you have just committed or saved. You’ll get a pop up box asking if you want to continue undoing your “area” or “line” edit. Then it goes backwards until it reaches the end of everything you have saved or committed during that session. Once you close the file, you cannot “Undo” anything.</td>
</tr>
</tbody>
</table>
H. To Reset the Edit Layer (Use with caution!)

**Note:** Before you use this tool it is important that you realize that it completely deletes all of your saved VTD delineations from all current and past sessions. This does not include BBSP flags that have been set. Any BBSP “Hold” or “Do not hold” flags that you have set will not be deleted.

1. Click ![unlock] in the “VTD Editing” toolbox. The MTPS displays a message confirming that you want to delete all of the VTDs you have created in the edit layer and start over.

2. Click “Yes.” The MTPS displays the “Area Settings” dialog box.

3. Click the “Start with existing features,” “Create empty layer,” or “Import Equivalency” radio button.

4. Click “OK.”

The MTPS resets the VTD layer.

I. Backing Up Your Work

If you would like to backup your work, there are 2 options:

**Option 1:** Copy the entire county subfolder for the county you want to back-up to another location. When you want to restore to the backed up version, you need to replace the county subfolder (with MTPS closed) in your main MTPS data folder with the one copied as a back-up.

**Option 2:** First, verify and report changes (as instructed in Section VI.) and save the Return.zip file that is created. Then follow the instructions in Attachment J to import your Return.zip file back into the MTPS.

J. Data Corruption

In extreme cases where the files become corrupted for an individual county, it may become necessary to reset that county's data. Follow the instructions in Attachment J to perform this operation.
II. Creating and Modifying VTDs

A. To Create a New VTD

When you open the county in which you want to work, select “Create empty layer” from the “Area Settings: Voting District” box.

NOTE: When beginning your plan with the “Create Empty Layer” selection, if you encounter any difficulty in getting the MTPS to accept your first new district in any given county please contact the Redistricting team at geo.redistricting.list@census.gov.

As you create your VTDs, the MTPS applies a color to the individual VTD, and adjacent VTDs will receive a different color. You can adjust the color scheme with the MapÆColoring box. This will only change the “scheme”. You cannot select a specific color for a specific VTD.

Note: At any time during your VTD delineations you may want to see a list of all of the existing VTDs to review all the VTDs you have created at this point. When the “VTD Editing” toolbox is open you can generate an inventory file for all current VTD codes with associated names by county by selecting “VTD” from the dropdown menu on the “Standard” toolbar and then clicking on the “New Dataview” icon. Two other columns in this “Dataview” are:

- **VTD1**: This stands for Voting District Indicator. A = Actual; P = Pseudo.
- **LSAD**: This stands for legal statistical area description. These are codes that determine the way the names of some entities will appear in products. A V2 means the words "Voting District" would be used as a suffix along with the district's name. A V1 would use "Voting District" as a prefix. A 00 indicates that there is no suffix or prefix.

Note: Turn off or hide the water layer in the “Map Layers” dialog box any time you are adjusting VTD coverage because that layer will appear on top of the VTD layer, making it difficult to view the VTD coverage.

1. Make sure that “Voting District” is selected from the “Edit Layer” dropdown list in the “VTD Editing” toolbox.

2. Choose “New District” from the “Target Area” dropdown list.

3. Choose the source of the areas to select from the “Source Area” dropdown list. You can choose “All” or “Unassigned” areas. Only choose “Unassigned” areas if you are trying to ensure that you have complete coverage or if you want to make sure you do not select a face already assigned to another VTD.
4. Choose the selection layer from the “Selection layer” dropdown list.

- If your VTD is coextensive with a place, MCD, etc., you may want to select that area as the “Selection layer.” Otherwise, select faces.

5. Use the tool to select one or more areas or the tool to select areas within a shape. If you use the select areas within a shape tool, when drawing the “fence” or “lasso” around the desired selected area for the new VTD, click at each point and left double-click to complete the “fence.” The faces that are entirely inside the selected area are highlighted. When you use the tool, you can click on one or more areas, or click and drag a rectangle around areas to select them. You can also hold the Ctrl key and click on selected areas to remove them from the selection.

- When annotating a VTD boundary along a road that is shown as a double-line you can select the faces along either one of the lines to be the boundary, but be consistent. For some of the hydrographic features, there may be three lines for selection: (1) The left shore, (2) the middle centerline, or (3) the right shore. You may select any of these, but be consistent throughout the length of the boundary edge.

6. To change the way areas are selected, return to Step 3 to change the source of the areas or Step 4 to change the selection layer. To cancel the selections for the VTD you are currently working and not all VTDs created during this session, click .

Note: If your VTD boundary follows a nonvisible line or a visible feature that is not in the MTPS, you need to add a line to create your VTD. (See the “To Add a Line” section on page 31.)

7. When you have created your VTD, click to save your work and to display the “Voting District Attributes” dialog box. You must type a valid VTD code in the “Code” edit box. It is the only required attribute.

- VTD codes can range from 1-6 alphanumeric characters. This includes dashes, dots, spaces, or forward slashes. If you want to use a different character, notify the RCC staff.

- VTDs are often, but not required to be, named. If the VTD has a name, type a name in the “Name” box. If a name is not supplied, the Census Bureau will use the VTD code as the name. Names can be up to 100 characters, including alphanumeric, spaces, and all special characters. Names appear on the Census Bureau’s data website, the American FactFinder, and in the PL 94-171 summary files when the data is released after the 2010 Census.
Codes and names should be consistent and should be reviewed for spelling accuracy, keeping in mind that these names will appear in public products.

We request that you code all areas, including water, to a VTD. If you do not code each area, the Census Bureau will assign the code of “ZZZZZZ” to the unassigned areas. This allows us to ensure we have all areas coded to a VTD.

If the VTD is an “actual” district, uncheck the “Pseudo” box. Otherwise, it will be considered “pseudo.”

An “actual” VTD is one that exactly matches the precincts or other election areas in your state. You may choose to identify your submitted VTDs as “actual.” Otherwise they will be considered “pseudo” so as not to confuse the data user. For example, states may choose to identify multiple layers of election areas within their VTD framework and may wish to identify them as pseudo. This is an acceptable approach to the submission of the VTD plans.

If you submitted voting district delineations for Census 2000 that were designated as “actual,” then the file that you get in the MTPS for Census 2010 will have "actual" designation. If this is no longer accurate, you will need to review the appropriate voting districts and make the necessary changes.

Create/edit relationships in the “Voting District Attributes” dialog box as follows:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create a relationship</td>
<td>Click +, choose a relationship type from the “Relationship” dropdown list, choose an entity type from the “Entity Type” dropdown list, and select a FIPS code from the FIPS Code dropdown list.</td>
</tr>
<tr>
<td></td>
<td>• To find the name that matches the listed FIPS code: From the dropdown menu on the “Standard” toolbar, select “Incorporated Place” and click on the “Dataview” icon.</td>
</tr>
<tr>
<td>To remove a relationship</td>
<td>Highlight the relationship and click X</td>
</tr>
<tr>
<td>To add other relationships</td>
<td>Type the relationships in the “Other Relationships” dialog box, using the abbreviations CC for completely contains, WW for wholly within, CO for coextensive.</td>
</tr>
</tbody>
</table>

8. Click “OK.”

The MTPS saves the attributes.

See Attachment B for detailed information regarding the various types of relationship information that we want to receive.
B. To create VTDs Using a Layer From Your Database as the Source

Some states maintain a VTD layer in their own GIS software. The MTPS allows users to import these files and use them as a starting point for adding these VTDs to the Census Bureau supplied data shapefiles. To import data from your GIS and create a new layer, do the following steps:

1. When you open the county in which you want to work, select “Create empty layer” from the “Area Settings: Voting District” box.
2. From the “Layers” dialog box, select “add a Layer.”
3. From the “File open” box, select the type of file you want added from the “Files of Type” dropdown menu.
4. Select your file.
5. Click “open.”
6. “ESRI shapefile” dialog box opens.
7. Click “coordinates.”
8. Set “Data Conversion” if necessary, to NAD 83. For example, if your shapefile is USA NAD 27, select “USA NAD 27 to NAD 83.”
9. Click “OK.”
10. The file appears in the “Layers” menu as a new layer.
11. Change the “Styles” of borders, fills, etc., in the “Layers” dialog box. Set the style to a symbology that is conducive to seeing the local VTD boundaries superimposed on the file. A “Border Style” with a “dashed” symbology, “Border Color” of “red,” and “Border Width” of “1.5” is one suggestion.
12. Set the labels to identify the VTDs by clicking on “Labels.” Scroll to “Precinct” on the “Field” at the “Centered” “Position” with “Arial” “Font” at “Size” “16” “Bold” is one suggestion.
13. Click “Apply.”
14. Close and re-open the “VTD Editing” toolbox.
15. Now you will see the layer you added as a layer selection in the “Layers” dialog box.

When you add an external file (a local GIS file, table, or imagery) to your MTPS project, it is essential that you not move the file from the location from which it was added. To do so will cause the application to be unable to open since it will not be able to find the added file and it will crash. However, the file can be moved back into the folder where it was originally (MTPS will tell you for which file it is looking and in what directory) and MTPS will be able to open up as normal, after which time you can drop the layer, move the file, and re-add the layer from its new location.

To avoid this problem, it is important to either remove the added local file from the layers before closing the application or be certain to not move the file's location and be sure you have any needed network connections to the file's location when you re-launch the application.

C. If Your State Data Does Not Match Census Bureau Data

Since the data displayed in your imported layer may not align exactly to ours, you may have to cleanup around the edges. For example, if your VTD follows a school district boundary and the location of the school district is different in the two files, you must use our school district boundary location. This situation is demonstrated in the graphic below. If you think the school district boundary is incorrect or is out-of-date, contact the Geography Division by sending an e-mail to GEO.redistricting.list@census.gov. If the boundary needs to be corrected, we will work with our school district mapping coordinator to correct our school district boundaries, and if they agree, the change will be reflected in a later Census Bureau shapefile product.

To ensure that the VTD and the school district boundary maintain that relationship, provide relationship information as instructed in Attachment B.
Census Bureau and Local School District boundaries have a similar shape but are in different locations.

Boundary Kinks and distortions

Some states are finding that their state boundaries and other boundaries for legal areas within their state have kinks and boundary distortions. Here is an example of what you might find in your data file:
If you can not correctly delineate the boundary for an entity you are updating because the feature you need to follow is incorrectly located, mislabeled or distorted in the Census Bureau’s file, we request that you put the boundary on the problematic feature in our file. This will establish for us what feature you want the boundary to follow. In addition, we request that you report the problem area to the Census Bureau (through your regional office contact) by sending information describing the incorrect feature including the TIGER Line Identifier (TLID) and the specific entity boundary affected. This can be done using e-mail with information to describe the problem such as an image file, PDF or other medium showing the appropriate correction.

Legal Boundary Corrections; State/County/MCD/Place

The Census Bureau can not accept city, minor civil division, county, or American Indian Area boundary changes from VTD/BBSP respondents. It is very important that this boundary information be coordinated within the state and come to the Census Bureau through the BAS respondent. In some states the Census Bureau has a state-level BAS agreement and we can provide more information about these agreements upon request.

As you are completing the work for VTD/BBSP, you may notice legal boundaries that are not up-to-date. When this occurs, we request that you contact the BAS respondent in your state and encourage them to report all changes to the legal boundary for the governmental unit. To receive the appropriate BAS contact information, submit an e-mail to geo.bas@census.gov. Include in the e-mail, the entity in question, your name, phone number, and if possible an e-mail address.

D. To Create VTDs Using Your Block Equivalency File

WARNING: If you have begun work on a county using this method, using version 4.6 or earlier of the MTPS, you must complete that county before updating your MTPS to the new version 4.7.

This approach should only be used if you have maintained your VTDs using Census blocks. If you decide to use this process, you will get a better result if you use the most current Census blocks to create your block equivalency file (BEF). As the MTDB is updated with new legal boundaries (for example, city boundaries) or with new roads, the Census 2000 tabulation blocks are divided into smaller blocks through a process called “block suffixing.” For example, a Census 2000 tabulation block number of 1004 may now be divided into smaller blocks that are numbered 1004a, 1004b, and 1004c. These “current” blocks have been provided in public TIGER/Line products over the years. If the block in
your file is “1004,” and does not contain the current suffixes (if that block has been suffixed), the MTPS will not associate a VTD code to the faces in the suffixed blocks. You can find and fix these unassigned areas during a VTD editing session using the MTPS, as described in Section III.

Block Equivalency File Format

In order for this process to work, the state BEF must contain at least two fields in each record. The first required field (named BLOCKID in the graphic below) contains concatenated state, county, tract and block codes. If you are using current blocks, there may be an additional block suffix appended at the end of the block code. For example, BLOCKID would appear as 180159595001017, where 18 is the state FIPS code, 015 is the county FIPS code, 959500 is the tract number and 1017 is the block number. If the block is suffixed, the BLOCKID would appear as 180159594002028A, containing the additional block suffix “A.” If your BEF currently shows those geographic areas as separate fields, they need to be concatenated into a single field before performing the import. The second required field is the VTD_CODE. If you want to add VTD names during the import, the BEF requires an additional field that includes the names (VTD_NAME below).

Sample BEF

<table>
<thead>
<tr>
<th>STATEFP</th>
<th>COUNTYFP</th>
<th>TRACT</th>
<th>BLOCK</th>
<th>SUFFIX1</th>
<th>SUFFIX2</th>
<th>BLOCKID</th>
<th>VTD_CODE</th>
<th>VTD_NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>016</td>
<td>955600</td>
<td>1017</td>
<td></td>
<td></td>
<td>180159595001017</td>
<td>11111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955600</td>
<td>2037</td>
<td></td>
<td></td>
<td>180159595003023</td>
<td>1111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955600</td>
<td>2033</td>
<td></td>
<td></td>
<td>180159595003033</td>
<td>1111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955600</td>
<td>1016</td>
<td></td>
<td></td>
<td>180159596001016</td>
<td>1111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955700</td>
<td>1069</td>
<td></td>
<td></td>
<td>180159597001069</td>
<td>1111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955600</td>
<td>3027</td>
<td></td>
<td></td>
<td>180159596003027</td>
<td>9999999</td>
<td>Volhalla Central</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955700</td>
<td>3020</td>
<td></td>
<td></td>
<td>180159597003020</td>
<td>9999999</td>
<td>Volhalla Central</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955500</td>
<td>1064</td>
<td></td>
<td></td>
<td>180159595001064</td>
<td>9999999</td>
<td>Volhalla Central</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955500</td>
<td>2043</td>
<td></td>
<td></td>
<td>180159595002043</td>
<td>1111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955400</td>
<td>2028</td>
<td>A</td>
<td></td>
<td>180159594002028A</td>
<td>1111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955300</td>
<td>2032</td>
<td>A</td>
<td></td>
<td>180159593002032</td>
<td>1111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955300</td>
<td>5005</td>
<td>A</td>
<td></td>
<td>180159593005005A</td>
<td>1111111</td>
<td>Emerald City</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955700</td>
<td>3029</td>
<td>B</td>
<td></td>
<td>180159597003029B</td>
<td>9999999</td>
<td>Volhalla Central</td>
</tr>
<tr>
<td>10</td>
<td>015</td>
<td>955700</td>
<td>2070</td>
<td></td>
<td></td>
<td>180159597002070</td>
<td>9999999</td>
<td>Volhalla Central</td>
</tr>
</tbody>
</table>

Each field in the state's block equivalency file should have a descriptive name such as BLOCKID and VTD_Code. This will make it easier to identify and select the fields when using the importer. If the fields are not given a name, the first record in each field will appear in the drop down lists (described below) as the field names.
To create your VTDs starting with a BEF that you have maintained in your own database or GIS application, select “Import Equivalency” from the “Area Settings: Voting District” box, when you open the county in which you want to work.

Click OK. The “Choose File to Import” box appears as here: (The MTPS only supports the following file types: .bin, .txt, .csv, .dbf, .asc.)

Choose a file and click Open.
MTPS displays the “Import Block Equivalency File” dialog box. Choose the field from your BEF which matches the block field from the “Match Block Field To” dropdown list and the field which contains the district code from the “Fill District From” dropdown list. If your BEF contains VTD names, choose the field from your BEF which contains the names from the “Fill New Name From” dropdown list.

In the sample BEF above, the BLOCKID field would be used in the “Match Block Field To” pull-down menu. VTD_CODE would be used in the “Fill District From” pull-down menu. VTD_Name would be used in the “Fill New Name From” pull-down menu. Additionally, you may designate your VTDs as “Actual” by checking the box as shown in the graphic above. Otherwise, your VTDs will be designated at “Pseudo.” Click OK.

Once the import is completed, the MTPS fills your county based on the VTD codes included in your file. However, as mentioned before, if the block record in your file does not contain the current suffixes (if that block has been suffixed), that block will not be filled with a VTD code.

Each VTD will appear highlighted in a different color so that you can distinguish adjacent VTDs. Then proceed with the following steps:

1. Find and fix any unassigned or non-contiguous areas using an editing session as described in Section III.

2. Review the boundaries of these VTDs. This is a very important step. Make sure that each VTD is following the feature that you want it to follow. The Census Bureau’s MTDB has changed significantly since Census 2000 and this can affect the feature to VTD relationship.

3. Click in the “VTD Editing” toolbox to display the “Attributes” dialog box if you want to change the codes, names, relationships, or the “Pseudo” assignment. Note that the existing VTD must be selected in the “Target Area” dropdown menu of the “VTD Editing” toolbox.
4. If you want to create a new VTD using these VTDs as a starting point (for example, you want to create two new VTDs from one existing VTD), “New District” must be selected in the “Target Area” dropdown menu.

E. To Create VTDs Using Your Census 2000 VTDs

To create VTDs using your Census 2000 VTDs, select “Start with existing features” from the “Area Settings: Voting District” box, when you open the county in which you want to work. Each VTD will appear highlighted in a different color so that you can distinguish adjacent VTDs.

1. Review your previous VTDs. Make sure that each VTD is following the feature that you want it to follow. Some updates in the MTDB may have caused a feature to change its location. If you need to modify any of your existing VTDs, follow the instructions in Section II. F.

2. Click in the “VTD Editing” toolbox to display the “Attributes” dialog box if you want to change the codes, names, relationships, or the “Pseudo” assignment. Note that the existing VTD must be selected in the “Target Area” dropdown menu of the “VTD Editing” toolbox.

3. If you want to create a new VTD using your Census 2000 VTDs as a starting point (for example, you want to create two new VTDs from one existing Census 2000 VTD), “New District” must be selected in the “Target Area” dropdown menu.

F. To Modify a VTD That Has Been Created Using Any of the Above Methods

1. Make sure that “Voting District” is selected from the “Edit Layer” dropdown list in the “VTD Editing” toolbox.

2. Choose the existing district from the “Target Area” dropdown list. The VTD that you select will highlight in grey. The “Zoom to Area” tool on the “VTD Editing” toolbox is very helpful in locating the area.

3. Choose the source of the areas to select, from the “Source Area” dropdown list. You can choose all areas, unassigned areas, or an existing area.

4. Choose the selection layer from the “Selection layer” dropdown list.

5. Use the tool to select one or more areas or the tool to select areas within a shape. If you use the select areas tool when drawing the “fence” or “lasso” around the desired selected area for the new VTD, click at each point and left double-click to complete the “fence.” This selected area is highlighted. When you use the tool, you can click on one or more areas,
or click and drag a rectangle around areas to select them. You can also hold the Ctrl key and click on selected areas to remove them from the selection.

If you want to remove everything you have selected during this VTD modification, click 🗑️.

**Note:** You can hover your cursor over any area to find out what VTD is there. A text box will pop up with the VTD code and name.

6. To change the way areas are selected, return to Step 3 to change the source of the areas or Step 4 to change the selection layer.

7. Click 🗯️ to modify the existing district.

The MTPS modifies the VTD.
III. Editing your VTDs

To ensure you have completed your VTD delineations and that your VTDs are as you want them to be, the MTPS is designed with built-in edits. There is one for finding unassigned areas and one for finding noncontiguous areas.

A. To Find Unassigned VTD Areas

1. To ensure that no part of a county has been left without an appropriate VTD code, choose “Voting Districts” from the “Edit Layer” dropdown list in the “VTD Editing” toolbox.

2. From the top menu, choose VTD/BBSPÆFind Unassigned Areas. If there are no unassigned areas, the MTPS displays a message and does not display the toolbox. Otherwise, the MTPS displays the “Find Unassigned Areas” toolbox. The unassigned areas appear and are sorted by area size; the largest area is first on the list.

3. Make choices as follows:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom to unassigned areas</td>
<td>Highlight one or more areas in the scroll list and click</td>
</tr>
<tr>
<td>Update the list of unassigned areas</td>
<td>Click</td>
</tr>
</tbody>
</table>

4. Assign all unassigned area using the steps outlined in Section II. F. When all unassigned areas have been assigned, click the refresh icon and a note box will appear saying there are no unassigned areas. Click “OK.”

The MTPS closes the “Find Unassigned Areas” toolbox.

B. To Find Noncontiguous VTDs

1. To ensure that all noncontiguous VTDs are intentional, choose “Voting Districts” from the “Edit Layer” dropdown list in the “VTD Editing” toolbox.

2. From the top menu, choose VTD/BBSPÆFind Non-Contiguous Areas. If there are no noncontiguous areas, the MTPS displays a message and does not display the toolbox. Otherwise, the MTPS displays the “Find Non-Contiguous Areas” toolbox.
3. Make choices as follows:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom to non-contiguous areas</td>
<td>Highlight one or more areas if they are the same VTD in the scroll list and click [button]</td>
</tr>
<tr>
<td>Update the list of non-contiguous areas</td>
<td>Click [button]</td>
</tr>
</tbody>
</table>

4. If necessary, make any corrections by following steps in **Section II. F**. When you are done with the toolbox, click the close box in the upper right corner.

The MTPS closes the toolbox.
IV. Adding Lines and Providing Imagery

As mentioned in the General Guidelines, the next Census Bureau effort for updating roads will be the Address Canvassing Operation next spring/summer (2009). We will not insert new streets added during the initial VTD/BBSP program because those streets will be added during that operation. If multiple programs add the same roads, we run a significant risk of having duplicates in the file. Add a line during VTD/BBSP to represent a road or other missing feature only if that feature serves as a VTD boundary or is needed as a suggested block boundary and we require that you submit imagery to support the added feature. Verification materials will provide you an opportunity to review the roads added as part of our Address Canvassing Operation and add roads that were not picked up.

A. To Add a Line

Any line added too close to existing lines may not be accepted. To avoid this problem, we advise you to always use existing lines, if possible, when delineating your VTDs. If an added line repeatedly intersects or is within 10 meters of another line, the MTPS will ask if you can use the existing line.

The line numbers in the above “Confirm” box are called line IDs. If the line has no name, you will only see the line ID. If you want to review the referenced line, follow these steps:

- Make a note of the numbers in the box.
- Click Yes. (The line you just delineated will not be added to the map)
• Make sure that “All lines” appears in the drop down menu on the “Standard” toolbar at the top.
• Click on the “Dataview” Icon
• Click on “Edit” in the Standard menu at the top
• Click “Find”
• Type in the number in the “Dataview Find” box.
• Click OK.
• Right click on the Record ID.
• Select “Zoom”

MTPS zooms to the line. If you hover your mouse over the line, a box will pop up with the line ID number. You can then determine if the line referenced can be used or is in fact the feature you were trying to add. Lines added within 30 feet of an existing line will likely require interactive work to insert them into our topologically integrated file.

If instead of using the existing line, you choose to use your own added line, the RCC staff may contact you if there is a problem getting the line into MTDB using your updated shapefile submission.

1. Choose from the top menu, VTD/BBSP ➔ Line Editing Toolbox. The MTPS displays the “Line Editing” toolbox.

2. Click to activate the Add Line tool.

3. Click where you want to start the line.

4. Move the cursor and click to create shape points along the new line.

5. Be sure that you are zoomed in sufficiently to see that the end point is connected to another line if you intend to form a closed polygon. If you want to end the digitizing of a line without actually creating the line you have started, hit the Esc key. If you want to finish the line, double-click to end it. You may click at a node (either at an intersection or at the endpoint of a line), on a line, or in space. The MTPS adds the new line and displays the “All Lines – Editing Attributes dataview” box. (If the line is too close to, or intersects another line, the MTPS will display the “Confirm” dialog box above. Follow those instructions to review the suggested lines.)

6. In some instances you will have to modify the snapping distance to insert a line. To do this, choose from the top menu, Edit ➔ Preferences. On the System tab, change Snap Tolerance to the distance and units desired. Click "OK". Once you have inserted the line, restore the snap tolerance back to 50. This will prevent creating gaps when you try to add a feature where snapping tolerance isn’t a problem.
Note: In the “All Lines – Editing Attributes dataview,” only the “MTFCC” (required) and “fullname” fields should be filled out.

7. Double-click the panel to the right of “MTFCC” (MAF/TIGER Feature Classification Code) and select a feature type from the dropdown list.
   - If you are creating the line to be a nonvisible VTD boundary, choose P0001 (Nonvisible legal/statistical boundary).
   - If you are creating a line to be a feature extension, choose P0004 (Other nonvisible bounding Edge (e.g., Census water boundary, boundary of an areal feature). See feature extension criteria in Section V. A. on page 36.

8. Click the icon to the right of “FULLNAME” to enter the name. If the feature you added does not have a name (for example, a township and range line or a rear property line), we require that you describe the line being added in the “FULLNAME” field as follows:
   - Right click in the “FULLNAME” field
   - Add comment (Township and range line or rear lot line off Y street)

9. Click to add the line or to cancel the added line. You can also go to Edit → Undo, while still in the map window, to cancel any added saved lines.

Also with the “Line Editing” tool, you can delete, split, and copy lines; edit line attributes; and display names and address ranges. If you delete a line that has been added and saved, it will appear as a red dashed line. For more information on this toolbox, review the Editing Linear Features lesson in the CBT. Also, you can highlight the tool and press F1.

To add or delete a physical feature requires providing imagery or a reliable map source to prove that the feature exists or no longer exists. You can do any of the following:

- add imagery from TerraServer USA
- add your own imagery as a layer
- mail or fax an image or map
- provide a URL to display an image or map

Line Attributes on Pre-Existing Features

Pre-existing line attributes, including addresses, are not editable in the Redistricting Data Program version of the MTPS. You can use the "Add a Comment" functionality, as follows. These comments can then be reviewed by the RCC staff when the submission is received.
1. Line edit tool
2. Edit line attribute button
3. Select line
4. Right click in the field you want to update
5. Add comment

Regarding address ranges, when a line is split in the MTPS, both segments retain the original address range. The split line will be digitized and the address ranges will be imputed in MTDB. Currently, there is no mechanism for RDP participants to provide address range information.

B. Importing Digital Imagery from TerraServer USA

Microsoft Corporation maintains TerraServer-USA, an on-line database of high resolution USGS aerial imagery and scanned USGS topographic maps. If you have Internet access, you can use it to get an image to add as a new layer in your map.

The .NET Framework must be installed to use this command; for more information, see Download details: .NET Framework (http://www.microsoft.com/downloads/details.aspx?FamilyID=262d25e3-f589-4842-8157-034d1e7cf3a3&displaylang=en)

To add TerraServer USA imagery, click on Tools ➔ Imagery ➔ TerraServer USA Toolbox. Click to retrieve the image.

Note: If you save an image to be included in your submission, choose “Jpeg” in the “Files of Type” dropdown menu, in the “Save As” dialog box. Be sure to include the state and county FIPS codes as part of the name.

To learn more about adding imagery, see the Using Images in a Map lesson in the CBT. Also, when you activate the “TerraServer-USA Image Tool” toolbox, press F1 and you will be directed to the on-line help documentation for that toolbox.
C. Adding your own Digital Imagery as a Layer

To add your own digital imagery as a layer, use the “Add a Layer” function as described in Section II. B. on page 20. The imagery must be in a geo-referenced format. You must export your image into a format that can be read by the MTPS. These can be seen by using the “Add a Layer” function and then using the File Type pull down. If you submit this imagery to the Census Bureau in support of your feature adds and deletes, be sure to include the state and county FIPS code as part of the name.

D. Mailing or Faxing and Image or Map

If you want to provide an image or a map to show that a feature does or doesn’t exist, you can mail or fax it to your RCC office.

To provide information for an added line, when you create your line in the MTPS, add a comment as follows:

1. Line edit tool
2. Edit line attribute button
3. Select line
4. Right click in “FULLNAME” field
5. Add comment
6. Type in the name of the image or map, i.e. “State and County name and FIPS code, Image A.”

To provide information for a deleted line, if the image or map shows that a line no longer exists, when you select the line for deletion, write an explanation in the “Add a Comment” box that pops up and reference the image or map that has been mailed or faxed to the RCC.

Clearly label your image or map including the same information.

E. Providing a URL to Display an Image or Map

To supply a URL to display an image or map, add a comment as described above, but for number 6, type in the URL and the state and county name and FIPS code.

It is necessary, when providing URLs to existing imagery, that you provide the full path to specific imagery that contains a close up of the feature or area being revised or added. This will increase the likelihood that we will accept the identified changes.
V. Performing Block Boundary Suggestion Tasks

The data you will receive as part of Phase 3 of the Redistricting Data Program includes data at the census tabulation block level. Therefore, the Census Bureau gives states the opportunity to suggest visible features for use as 2010 Census tabulation block boundaries. Because we are allowing VTDs to be inserted into our database as nonvisible lines and these lines will automatically become a 2010 Census tabulation block boundary, you do not need to identify these as block boundary suggestions. To identify other linear features that you want us to hold or not hold as 2010 Census tabulation block boundaries, you will use the “BBSP” toolbox. You can also create Block Area Groups using this toolbox if it is desirable for several islands to be in a single 2010 Census tabulation block.

All “Hold” block boundary suggestions are contingent upon the lines intersecting to form a closed polygon at the time we create the 2010 Census tabulation blocks, which will be in the fall of 2010. For this reason all block boundary suggestions must form a closed polygon.

A. Feature Extension Criteria

If you want to use an existing feature that doesn’t form a closed polygon, you may add a short line to connect the features and close the polygon. The Census Bureau refers to these lines as feature extensions and several requirements pertain. To avoid creating ambiguous Census block boundaries, we require that feature extensions:

- be no longer than 300 feet;
- be straight lines from the end of a road and intersecting a non-road feature (These include all hydrographic features, pipelines, powerlines, and railroads. Highways and freeways are acceptable as long as it is confirmed that there are no housing units on them. This situation has the potential for causing a housing unit to be in the wrong Census 2010 tabulation block.);
- do not intersect a cul-de-sac.

Instructions for viewing Census 2000 feature extensions are found in Section V. G. below on page 36.

To create a new feature extension, add the line as described in Section IV.A on page 31. Number 7 in that section describes how you should identify the line.

B. Planned 2010 Census Tabulation Block Boundaries

Below is a list of all the feature and boundary types that are currently planned to be held as 2010 Census tabulation block boundaries and therefore do not need
to be suggested as a “Hold.” In some instances you may NOT want the line to become a 2010 Census tabulation block boundary. A good example of where you may want to flag a feature with a “Do Not Hold,” is where we have roads identified in our files as double lined roads. Due to MTAIP, there are now many more roads in the MTDB classified as double line roads that, in the past, were classified as single line roads. This causes the area in the middle (a median strip for example) to become a long narrow block. If you do not want the polygon formed by the two road edges to be a separate 2010 Census tabulation block, you may want to flag one of the edges with a “Do Not Hold.”

**Note:** If any other program sponsored by the Census Bureau uses that line as a boundary, the Census Bureau will override the “Do Not Hold” status of the line.

**Entities:** The boundaries, as of January 1, 2010, for each of the entities listed below, are planned 2010 Census tabulation block boundaries and therefore do not have to be selected as part of the BBSP work.

<table>
<thead>
<tr>
<th>MTFCC</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G2120</td>
<td>Hawaiian Home Land</td>
</tr>
<tr>
<td>G2130</td>
<td>Alaska Native Village Statistical Area</td>
</tr>
<tr>
<td>G2140</td>
<td>Oklahoma Tribal Statistical Area</td>
</tr>
<tr>
<td>G2150</td>
<td>State-designated Tribal Statistical Area</td>
</tr>
<tr>
<td>G2160</td>
<td>Tribal Designated Statistical Area</td>
</tr>
<tr>
<td>G2170</td>
<td>American Indian Joint Use Area</td>
</tr>
<tr>
<td>G2200</td>
<td>Alaska Native Regional Corporation</td>
</tr>
<tr>
<td>G2300</td>
<td>Tribal Subdivision</td>
</tr>
<tr>
<td>G2400</td>
<td>Tribal Census Tract</td>
</tr>
<tr>
<td>G2410</td>
<td>Tribal Block Group</td>
</tr>
<tr>
<td>G4000</td>
<td>State or State Equivalent</td>
</tr>
<tr>
<td>G4020</td>
<td>County or County Equivalent</td>
</tr>
<tr>
<td>G4040</td>
<td>County Subdivision</td>
</tr>
<tr>
<td>G4060</td>
<td>Sub-Minor Civil Division</td>
</tr>
<tr>
<td>G4110</td>
<td>Incorporated Place</td>
</tr>
<tr>
<td>G4120</td>
<td>Consolidated City</td>
</tr>
<tr>
<td>G4210</td>
<td>Census Designated Place</td>
</tr>
<tr>
<td>G5020</td>
<td>Census Tract</td>
</tr>
<tr>
<td>G5030</td>
<td>Block Group</td>
</tr>
<tr>
<td>G5035</td>
<td>Block Area Grouping</td>
</tr>
<tr>
<td>G5200</td>
<td>Congressional District</td>
</tr>
<tr>
<td>G5210</td>
<td>State Legislative District (Upper Chamber)</td>
</tr>
<tr>
<td>G5220</td>
<td>State Legislative District (Lower Chamber)</td>
</tr>
<tr>
<td>G5240</td>
<td>Voting District</td>
</tr>
<tr>
<td>G5400</td>
<td>Elementary School District</td>
</tr>
<tr>
<td>G5410</td>
<td>Secondary School District</td>
</tr>
<tr>
<td>G5420</td>
<td>Unified School District</td>
</tr>
</tbody>
</table>

Attachment D: Instructions for Completing the VTD/BBSP using the MAF/TIGER Partnership Software
VTD/BBSP, Version 3, December 2008
Features: The features listed below will qualify as 2010 Census tabulation block boundaries based on criteria. Those that qualify are shown in red in the MTPS. All others are available for selection except for those shown in blue.

**MTFCC** | **Description**
--- | ---
S1100 | Primary Road
S1200 | Secondary Road
S1400 | Local Neighborhood Road, Rural Road, City Street
S1500 | Vehicular Trail (road passable only by a 4-wheel drive)
R1011 | Main Line Railroad Feature
P0002 | Perennial Water

Note: Feature extensions and Powerlines are not planned to be held as 2010 Census tabulation block boundaries, but they are eligible to be selected as a “Hold.”

To assist you with choosing any features that you may want held or not held, the MTPS displays the following:

- all currently planned 2010 Census tabulation block boundaries as red lines;
- all lines that are currently considered ineligible for selection as a block boundaries as blue lines;
- lines that were selected as Census 2000 BBSP “Must Holds” and were held as Census 2000 tabulation blocks, as black lines;
- lines that were selected as Census 2000 BBSP “Do Not Hold” and weren’t held as Census 2000 tabulations blocks, as black dashed lines.

Your new 2010 “Holds” and “Do Not Holds” also will be displayed as black and black dashed lines, respectively.

To see a complete list of all MTFCCs (previously referred to as Census Feature Class Codes [CFCCs]), see Attachment I.
C. To Review Census 2000 “Must Holds” and “Do Not Holds”

The MTPS is designed to allow you to view the features your state identified as “Must Hold” or “Do Not Hold” during the Census 2000 BBSP. If you are interested in seeing these lines, follow the steps below.

From the Standard menu, select VTD/BBSP→BBSP Toolbox.

To review Census 2000 “Must Holds” and “Do Not Holds”:
1. Click the “Display Settings” icon.
2. Select “2000” from the “Use BBSP display settings for” dropdown menu.
3. Click “OK.”

In the “Map Legend,” “2000 Hold Status” appears.

D. To Review Planned and Ineligible 2010 Census Tabulation Block Boundaries

The lines flagged in our shapefile as planned 2010 Census block boundaries are identified as such based on their MTFCC or their role as a boundary in 2008. We did not run the full block algorithm when we flagged these lines. For this reason, roads that do not form a closed polygon are flagged as planned because of their characteristics as a road; they would still have to form a closed polygon at the time of block numbering in 2010 in order to serve as a block boundary. Also note that although small ponds are flagged as planned block boundaries, these shorelines will not become 2010 blocks if they are surrounded by a single land block.

To review planned and ineligible 2010 Census tabulation block boundaries:

From the Standard menu, select VTD/BBSP→BBSP Toolbox.

1. Click the “Display Settings” icon.
2. Select “2010” from the “Use BBSP display settings for” dropdown menu.
3. Select what you want displayed on the map and click “OK.”

E. To Make Block Boundary Suggestions

To select features for suggested “Holds” and “Do Not Holds”:

1. Make a choice as follows in the “BBSP” toolbox:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make Hold suggestions</td>
<td>Click the “Hold” radio button</td>
</tr>
<tr>
<td>Make Do Not Hold suggestions</td>
<td>Click the “Do Not Hold” radio button</td>
</tr>
<tr>
<td>Clear suggestions</td>
<td>Click the “None” radio button</td>
</tr>
</tbody>
</table>

2. Click to activate the “Select Feature” tool.

3. Click on one or more line features. The MTPS will display a warning message if a suggestion is not appropriate or if you are clearing a “Hold” or “Do Not Hold” suggestion.

4. If you are making a “Hold” suggestion for a line feature marked “Ineligible,” you must provide imagery to re-classify the feature. You can either attach an imagery file or reference an image on the internet by providing a URL. The MTPS displays the “Ineligible BBSP Feature” dialog box. Make choices as follows:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave the line feature unmarked</td>
<td>Click the “Leave unmarked” radio button</td>
</tr>
<tr>
<td>Enclose an image file</td>
<td>Click the “Enclose image file” radio button or click ..., and either type a file name or choose an image file, and click OK.</td>
</tr>
<tr>
<td>Provide URL</td>
<td>Click the “Reference image URL” radio button and type a URL</td>
</tr>
</tbody>
</table>

When applying a "Hold" to a feature extension that is designated as ineligible for selection, enter the word EXTENSION in the URL box when prompted for imagery.

If you want to use a TerraServer USA image, follow the instructions in Section IV. B., on page 34, and save the image to your hard drive. Then “Enclose an image file” as instructed above.

5. If you are making a “Do Not Hold” suggestion for a line feature marked as a “Planned Hold,” the MTPS displays a box saying that. Click “OK.”
Remember that the boundary of each governmental unit or statistical entity will be held as a 2010 Census tabulation block boundary as will most roads. Private roads, trails, and unimproved roads may or may not be held and therefore, are more the target of the “Do Not Hold” tool. Also, water features that are not double-lines with area are good candidates for flagging as a “Do Not Hold.”

If you still want us to consider the “Do Not Hold” do this:

- Line edit tool
- Edit line attribute button
- Select line
- Right click (One click) 2010 BBSP field (green box to the right of the header)
- Add comment (Do Not Hold and a short explanation as to why you do not want the line held)

At this time, in the MTPS display, the line will not appear as a black and white dashed line, as other “Do Not Hold” suggestions appear, and it will be evaluated by the RCC staff.

6. If you want to review comments that you have made to a feature, there are two ways to do so.

- Go back to the same feature, use the edit line attributes tool in the “Line Editing” toolbox, and click on the feature. Right click on the field you had edited before, go to “Add a Comment” and you will see the comment you typed before.

- Alternatively, you can look at a DBF file that is created during the “report changes” process and is one of the files automatically created in the return zip file. The file would be named like this: RDP_08123_LN_CHANGES_COMMENTS.DBF. There is no “one-stop” location to see a list of all the comments made until this dbf file is created during the “report changes” process described in Section VI.

7. If you are trying to suggest a “Hold” on a line that is already a “Planned Hold” (dark red line), the line will not appear as a bold black line, as other “Hold” suggestions do, but you should consider it flagged as a “Hold.”

F. To Change the BBSP Display Settings

1. Click ✉️ in the “BBSP” toolbox to display the BBSP Display Settings dialog box.
2. Make changes as follows:

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use all of the display settings</td>
<td>Check &quot;Use BBSP display settings&quot; and make sure that all of the items are checked</td>
</tr>
<tr>
<td>Use some of the display settings</td>
<td>Check &quot;Use BBSP display settings&quot; and make sure that the items you want to use are checked</td>
</tr>
<tr>
<td>Use none of the display settings</td>
<td>Remove the check from &quot;Use BBSP display settings&quot;</td>
</tr>
</tbody>
</table>

3. Click “OK.”

The MTPS redraws the map to use the display settings that you have chosen.

If you want to use the “Info” tool to determine the current BBSP values, the current values are as follows:

- BBSPFLG = 1: Census 2000 Must Holds
- BBSPFLG = 2: Census 2000 Do Not Holds
- CBBFLG = 4: Planned 2010 Census Block Boundary
- CBBFLG = 9: Ineligible 2010 Census Block Boundary
- 2010_BBSP = 1: 2010 Census Participant Hold (filled by participant)
- 2010_BBSP = 2: 2010 Census Participant Do Not Hold (filled by participant)

G. To Find 2000 Feature Extensions

The MAF/TIGER Accuracy Improvement Project spatially corrected the roads in our database. This includes roads that had feature extensions connecting the end of the road to another, usually non-road, feature. As the road moved to its correct new location, the point connecting the extension to the non-road feature did not move. This caused almost all the feature extensions in our database to be at an angle rather than straight. If you still desire a feature extension in these locations, we request that you add a new straight line and flag it as a “Hold.”

Note: Because the new MTFCCs don’t always match exactly to the old CFCCs, feature extensions are identified based on certain criteria. Therefore, some features identified by this function are not actual feature extensions.

From the Standard menu, select VTD/BBSP → BBSP Toolbox.
1. Click the “Display Settings” icon.

2. Select “2000” from the “Use BBSP display settings for” dropdown menu.

3. Click “OK.”

4. From the top menu, choose VTD/BBSP → Find 2000 Feature Extensions. If there are no 2000 feature extensions, the MTPS displays a message and does not display the toolbox. Otherwise, the MTPS displays the “Find 2000 Feature Extensions” toolbox.

5. Make choices as follows:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom to 2000 feature extensions</td>
<td>Highlight one or more entries in the scroll list and click the “Zoom to” button</td>
</tr>
</tbody>
</table>

Feature extensions are displayed as green lines.

6. When you are done with the toolbox, choose from the top menu VTD/BBSP → Find 2000 Feature Extensions or click the close box in the upper right corner.

The MTPS closes the “Find 2000 Feature Extensions” toolbox.

To create a new feature extension, see “To Add a Line” section on page 31.

H. To Review Block Boundary Suggestions

1. Make a choice as follows in the “BBSP” toolbox:

<table>
<thead>
<tr>
<th>To do this…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review Hold suggestions</td>
<td>Click the “Hold” radio button</td>
</tr>
<tr>
<td>Review Do Not Hold suggestions</td>
<td>Click the “Do Not Hold” radio button</td>
</tr>
</tbody>
</table>

When the “BBSP” toolbox is open, the MTPS shows the count of all suggestions and the position of the current suggestion within that count. The MTPS activates the navigation buttons as appropriate.
2. Use the navigation buttons as follows:

<table>
<thead>
<tr>
<th>Click…</th>
<th>To zoom to the…</th>
</tr>
</thead>
<tbody>
<tr>
<td>‹‹</td>
<td>First suggestion</td>
</tr>
<tr>
<td>‹‹‹</td>
<td>Previous suggestion</td>
</tr>
<tr>
<td>‹›</td>
<td>Next suggestion</td>
</tr>
<tr>
<td>››</td>
<td>Last suggestion</td>
</tr>
</tbody>
</table>

The MTPS zooms the map to show the suggestion. You can also click就是这样 to zoom to the current suggestion.

I. To Move Around the BBSP Map

Use the following buttons in the “BBSP” toolbox:

<table>
<thead>
<tr>
<th>To zoom to…</th>
<th>Do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>The entire map</td>
<td>Click [图片] Click [图片]. The MTPS zooms to show the entire map.</td>
</tr>
<tr>
<td>The current suggestion</td>
<td>Click [图片] Click [图片]. The MTPS zooms to show the current block boundary</td>
</tr>
</tbody>
</table>

You can also use tools in the “Tools” toolbox to move around the map.

J. To Create a Block Area Group (Island Grouping)

During the 2010 Census tabulation block delineation, the Census Bureau will automatically group islands to form a single tabulation block if they have no road features and fall within a 5 kilometer radius.

You also may group specific islands for identification as a single 2010 Census tabulation block. These are called Block Area Groups (BAGs). BAGs are exempt from the 5 kilometer radius requirement. To create a BAG:

1. Click [图片] in the “BBSP” toolbox to activate the “Create Block Area Group” tool.

2. Click at points around a set of islands, making sure not to cross any land areas, and double-click to complete the shape. You cannot cross an existing BAG perimeter, but you can connect a new BAG to the side of an existing one. If it crosses any other tabulation areas, it will be split along that line as well.
The MTPS checks whether the shape is valid. If so, the MTPS creates and shades the BAG. Otherwise, the MTPS displays a message and does not create the BAG.

K. To Delete a Block Area Group That You Have Created

1. Click in the “BBSP” toolbox to activate the “Delete Block Area Group” (BAG) tool.
2. Click in a BAG.
   The MTPS deletes the BAG.

L. Dividing Large Water Blocks

If you want to add a line to divide large water blocks for the BBSP program, add the line and assign an MTFCC of P0002. You must also assign a “Hold” status to the line.

M. Dividing Long Narrow Blocks formed by Medians

Due to MTAIP, there are now many more roads in the MTDB classified as double line roads that, in the past, were classified as single line roads. This causes the area in the middle (a median strip for example) to become a long narrow block. If you want these divided into smaller blocks, you could draw a feature extension from a nearby road or add a feature, such as a powerline, that is missing in the MTDB and flag it as a “Hold.” Also, if you do not want the polygon formed by the two road edges to be a separate 2010 Census tabulation block, you may want to flag one of the edges with a “Do Not Hold.”

N. To Verify Your VTD/BBSP Work

1. From the top menu choose VTD/BBSP ® Verify. The MTPS performs the tests. These tests include checking for noncontiguous and unassigned areas and closed polygons for “Hold” selections.
2. If the test fails for noncontiguous or unassigned areas, the MTPS displays an appropriate message. You can review these areas by choosing from the top menu, VTD/BBSP ® Find non-contiguous areas or Find unassigned areas. You’ll get a message to open your “VTD Editing” toolbox.

   If the test fails for closed polygons, the MTPS displays the “List Unclosed Polygons” dialog box. Make choices as follows:
To do this… | Do this…
---|---
Zoom to unclosed polygons | Highlight one or more entries in the scroll list and click .

Update the list of unclosed polygons | Click . If there are no more unclosed polygons, the MTPS closes the List Unclosed Polygons dialog box.

Fix your block boundary suggestions.

If you have made corrections and want to run VTD/BBSP → Verify again to make sure you have corrected everything that you intended to correct, be sure to re-open the “BBSP” toolbox.

When all of the tests pass, the MTPS displays the message “The verification of VTD/BBSP data was successful.” Click “OK” to close the message.
VI. Reporting and Viewing your Submission

A. To Report Your VTD/BBSP Changes

1. From the top menu choose VTD/BBSP → Report Changes. The MTPS displays a “Confirm” dialog box to make sure you want to create a ZIP archive of changes that can be sent to the Census Bureau.

2. Click “Yes.” If there are no changes to report, the MTPS displays a message. Click “OK.” Otherwise, the MTPS creates a ZIP archive called RDP_sccc_Return.zip (where sccc is a code based on the state and county FIPS code), puts it in the MTPS Data folder on the hard drive of your computer, and displays a message with the path to the archive. Click “OK” to close the message.

B. To View Your VTD/BBSP Changes After Reporting

1. Use Windows Explorer to navigate to the folder c:\MTPSData <county subfolder> and open RDP_sccc_Return.zip.

2. Extract all of the files into a folder, such as c:\Temp.

3. In the MTPS choose File → Open or click on the “Standard” toolbar, choose ESRI Shapefile from the “Files of Type” dropdown list, navigate to the folder where you extracted the Shapefiles, choose a “Shapefile,” and click “Open.” The MTPS displays the ESRI “Shapefile” dialog box, where the settings are correct.

4. Click “OK.” The MTPS displays a map with the Shapefile. You can return to Step 3 to open another Shapefile, or you can add one or more Shapefiles to the map by:
   - Choosing, from the top menu, Map → Layers to display the “Layers” dialog box
   - Clicking “Add Layer” to display the “Layers” dialog box
   - Choosing ESRI Shapefile from the “Files of Type” dropdown list
   - Highlighting one or more Shapefiles
   - Clicking “Open”; The MTPS displays the “ESRI Shapefile” dialog box, where the settings are correct
   - Clicking “OK” for each Shapefile; the MTPS returns to the “Layers” dialog box
Highlighting each added Shapefile, clicking “Style,” and choosing a different border color. Click “Apply” and “OK.”

Clicking “Close”; The MTPS displays the map with the added layers

C. Submitting Files Using the Census Bureau’s “Send a File Utility”

You can upload your files through Census Bureau’s Send a File Utility at: http://www2.census.gov/cgi-bin/sendfile. Or, you can go to the Census Bureau’s home page at www.census.gov and select:

- Subjects A-Z
- Access Data Tools
- Public file send utility

This utility allows file size up to 500 Mb.

Use the following steps to FTP your files to us:

1. Under Source Information (Local), click on the Browse button to navigate to the file that you wish to send. Select the file from the Choose file window by clicking on it. Click Open. The File to Send field now contains the file name. **Note:** You can send only one file at a time.

2. In the Target Information (Remote) section, you must enter /geo/VTD_BBSP/ST##_SS in the Directory to Receive File, where ## = your state’s two-digit FIPS code and SS = your state’s two-letter USPS abbreviation.

   **Examples:** if you are California, ## = 06 and SS = CA; if you are Iowa, ## = 19 and SS = IA. If you are not sure what your state FIPS code or your USPS state abbreviation is, please click on the following link: http://www.itl.nist.gov/fipspubs/fip5-2.htm

3. Do not make an entry for New File Name.

4. Under Notify by E-mail, type your e-mail address in the Sender’s E-mail Address field. In the Census Bureau Employee’s E-Mail Address field, enter GEO.Redistricting.list@census.gov.

   We are asking you to please send a separate e-mail to the same e-mail address using your regular e-mail account, to notify us when you have submitted updates for your state.

5. Then type in the Verification Code that you see (or numbers you hear) in the box on the screen.

6. After filling in all the fields correctly, click on Upload. If you find an error, click on Clear and repeat the steps.
Important Note!! If you must resubmit a file for any reason, you **must first rename the file**. If not, the utility will produce an error message. Please retain the default naming convention of **RDP_sscce_Return** when you rename it. For example: **RDP_42027_Return_revised.zip** or **RDP_42027_Return_2.zip**.

We encourage you to call your RCC or headquarters staff (GEO or RDO) at anytime with any questions, comments, or concerns. Contact information can be found in Section I. D. of the General Guidelines for the GEO and RDO staff and in Attachment C for the RCC staff.